Copyright © 2005-2018 KWizCom Corporation. All rights reserved.

**Company Headquarters**

KWizCom  
95 Mural Street, Suite 600  
Richmond Hill, Ontario  
L4B 3G2, Canada

E-mail: info@KWizCom.com  
Web site: [http://www.KWizCom.com](http://www.KWizCom.com)

**Sales**

E-mail: sales@KWizCom.com  
Telephone: +1-905-370-0333
## CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>3</td>
</tr>
<tr>
<td>introduction</td>
<td>5</td>
</tr>
<tr>
<td>General</td>
<td>5</td>
</tr>
<tr>
<td>Product Overview</td>
<td>6</td>
</tr>
<tr>
<td>Why did we build it?</td>
<td>6</td>
</tr>
<tr>
<td>Key Features</td>
<td>6</td>
</tr>
<tr>
<td>Installation Guide</td>
<td>7</td>
</tr>
<tr>
<td>Software Requirements</td>
<td>7</td>
</tr>
<tr>
<td>Server Requirements</td>
<td>7</td>
</tr>
<tr>
<td>Client Requirements</td>
<td>7</td>
</tr>
<tr>
<td>Installation Procedure</td>
<td>7</td>
</tr>
<tr>
<td>SharePoint 2010/2013/2016</td>
<td>7</td>
</tr>
<tr>
<td>post Installation</td>
<td>8</td>
</tr>
<tr>
<td>SharePoint 2010/2013/2016</td>
<td>8</td>
</tr>
<tr>
<td>Un-Installation Procedure</td>
<td>8</td>
</tr>
<tr>
<td>SharePoint 2010/2013/2016</td>
<td>8</td>
</tr>
<tr>
<td>Administration Guide</td>
<td>9</td>
</tr>
<tr>
<td>Product Activation</td>
<td>9</td>
</tr>
<tr>
<td>SharePoint 2010/2013/2016</td>
<td>9</td>
</tr>
<tr>
<td>Clipboard Manager for SharePoint Configuration</td>
<td>13</td>
</tr>
<tr>
<td>General</td>
<td>13</td>
</tr>
<tr>
<td>Step 1: Activate the Clipboard Manager feature at the required scope</td>
<td>14</td>
</tr>
<tr>
<td>Step 2: Configure Clipboard Manager Settings</td>
<td>14</td>
</tr>
<tr>
<td>User Guide</td>
<td>16</td>
</tr>
</tbody>
</table>
General .................................................................................................................................................. 16

What exactly can I copy from my desktop to SharePoint rich-text field? .................................................. 17

Copying content other than local documents/pictures ............................................................................. 19
INTRODUCTION

GENERAL

This document provides all the information needed to install, evaluate and deploy this KWizCom product:

▪ Introduction
▪ Installation Guide
▪ Administrator Guide
▪ User Guide
PRODUCT OVERVIEW

Clipboard Manager for SharePoint allows SharePoint content editors and contributors to easily copy rich content and images stored on their local pc’s MS Windows clipboard, to SharePoint rich-content fields.

Now you can quickly copy formatted text, tables and images from your MS Office document and paste into any SharePoint rich-text field!

WHY DID WE BUILD IT?

Customers that are trying to migrate their older document-based knowledgebase to SharePoint Wiki, find many times that the task is not that easy; an MS WORD document page that includes rich-text, tables and images cannot be copied just like that, but requires several steps including: saving and uploading each of the embedded pictures to a SharePoint library, then copy just the pieces of plain text, reformat the pasted text and embed the uploaded pictures in the right places.

The purpose of the Clipboard Manager for SharePoint is to bypass that obstacle by allowing content editors simply copy & paste rich-content and images from their local Windows clipboard into SharePoint rich-text fields – simple and quick!

KEY FEATURES

<table>
<thead>
<tr>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Feature</strong></td>
</tr>
<tr>
<td><strong>Clipboard Manager for SharePoint</strong></td>
</tr>
<tr>
<td><strong>SharePoint 2010/2013/2016/2016</strong></td>
</tr>
<tr>
<td>Copy formatted text from MS Office, PDF and other text documents (including tables and images)</td>
</tr>
<tr>
<td>Copy images from the Windows clipboard and paste into SharePoint rich-text fields</td>
</tr>
</tbody>
</table>
INSTALLATION GUIDE

SOFTWARE REQUIREMENTS

SERVER REQUIREMENTS
- SharePoint Server/Foundation 2010/2013/2016/2016

CLIENT REQUIREMENTS
- Microsoft Internet Explorer 9+, Google Chrome (latest version), Firefox (latest version)
- Windows 8+
- Microsoft Office WORD 2010/2013/2016

INSTALLATION PROCEDURE

SHAREPOINT 2010/2013/2016
1. Log in as SharePoint administrator account to your SharePoint front-end server.
2. Browse the product’s page on KWizCom’s website and click the “Go” link under the “Install using our Web Installer” section.
   This will start the KWizCom web installer

Note: The KWizCom Web Installer will automatically offer you to upgrade other existing KWizCom products on your farm, in case you have old versions installed. You can check which products you wish to update at this time.

3. In case you prefer just to download the relevant .wsp packages and manually deploy them, then in the web installer UI check the “Download only” option (3rd page in the installer’s wizard), OR download the product WSP packages by clicking their links under the “Download Installable Packages” section.
   After you manually download and unzip the product’s WSP packages or use the web installer to download the product’s packages, install the KWizCom product by simply running the “SP-
WSPInstaller” powershell script.

POST INSTALLATION

SHAREPOINT 2010/2013/2016

1. After installation is complete, 2 new features are added:
   a. Clipboard Manager Farm feature
   b. Clipboard Manager Site Collection feature
2. If you want the Clipboard Manager to be available across your entire SharePoint farm, activate the Clipboard Manager Farm feature.
3. If you want to have the Clipboard Manager functionality available only in specific site collection/s, then leave the farm feature inactive and activate the Clipboard Manager site collection feature in the required site collections.

UN-INSTALLATION PROCEDURE

SHAREPOINT 2010/2013/2016

Retract the solution using SharePoint central admin or by using stsadm/powershell command line.
This section describes all administration activities including: product localization, product configuration and customization.

**PRODUCT ACTIVATION**

KWizCom products are available for evaluation prior to purchase.

This way you can try our components and verify that they indeed meet your needs. Each evaluation version contains all features of the component’s production version. The only difference between the versions is that the evaluation version is time-limited and will operate for a period of one month.

Once you decide to purchase a KWizCom component you will need to **order** and then to **activate** the product. The steps that need to be taken next are listed below.

**SHAREPOINT 2010/2013/2016**

1. Order the product on the KWizCom website – [www.KWizCom.com](http://www.KWizCom.com), or contact our sales team at sales@kwizcom.com.

2. After the order was made, you can activate your installed evaluation version. Activation is done by the following steps:
   a. Open SharePoint Central Admin. On the main “Central Administration” page, you will see the “KWizCom Features Administration” icon:
b. Click the KWizCom Features Administration icon. You will be redirected to a page that allows you to manage all your installed KWizCom products’ licenses:

c. Click the “Manage License” link next to the product that you wish to activate. You will be redirected to that product’s license management page:

d. Click on the “Request product code and start your evaluation now” link.
A product code will be generated and displayed as in the following screenshot:

```
<table>
<thead>
<tr>
<th>Product Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name:</td>
</tr>
<tr>
<td>Version:</td>
</tr>
</tbody>
</table>

**Form License**

- License type: [Evaluation]
- Expiration: [Thursday, November 10, 2010]

**Web Application or Site Collection License Management**

- [Use the form below to activate SharePoint File Controller Feature on one selected site collection or web application only.]

**Web Application License**

- [Copy your Product Code into the “Product Code” field, and after you fill-out all other form fields, click “Send Activation Request button.”]

**Product Activation Request**

In order to deactivate a product please click here.

The Product Activation Form is used to get your product activation key after you have purchased the product. Please fill out the following form. Once we get your product activation request, a product activation key will be sent to you by email along with the activation process description.

- [Customer Name]
- [Email address]
- [Share-Out Order/Service Number]
- [Product Code]
- [Product License Type]

[Send Activation Request]
```

e. Copy the product code.

f. Browse the Product Activation Request page on KWizCom’s web site:
   [http://www.kwizcom.com/ProductReg](http://www.kwizcom.com/ProductReg).
g. Once your order is confirmed, you will receive the Activation Code for your product by email.

h. Copy the activation code into the “Activation Code” field in the product’s license management page and click “Activate now!” link.

That’s it! Your product is now fully activated.
## CLIPBOARD MANAGER FOR SHAREPOINT CONFIGURATION

### GENERAL

The Clipboard Manager for SharePoint enables content editors to easily copy & paste rich content from MS Office documents and images from the user’s local Windows clipboard.

The solution includes the following modules:

<table>
<thead>
<tr>
<th>Module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clipboard Manager Farm Feature</td>
<td>A farm feature enabling activating the clipboard manager for the entire farm (disabled by default).</td>
</tr>
<tr>
<td>Clipboard Manager site collection Feature</td>
<td>A site-collection feature. Use this feature when you do not want to enable the Clipboard Manager across your entire farm, but only in specific site collections.</td>
</tr>
<tr>
<td>Clipboard Manager Settings page</td>
<td>This page allows configuring settings of the solution in site collection, site and list levels. In each level you can inherit from the parent level or override it with other settings.</td>
</tr>
<tr>
<td>KWizCom Client Agent</td>
<td>This tool needs to be downloaded by each user after the Clipboard Manager has been activated, the user will be prompted to download the tool when trying to paste something for the 1st time. The KWizCom Client Agent runs on the user’s local Windows and interacts with MS Office and the local machine’s Windows clipboard.</td>
</tr>
</tbody>
</table>

Before users can start using the Clipboard Manager for SharePoint, there are few settings that require configuration.

The following sections provide a step-by-step guideline of these required settings.
STEP 1: ACTIVATE THE CLIPBOARD MANAGER FEATURE AT THE REQUIRED SCOPE

If you wish to enable the Clipboard Manager functionality across your entire SharePoint farm, then you should make sure that the “KWizCom Clipboard Manager for SharePoint farm feature” farm feature is active.

If you wish to enable the Clipboard Manager functionality only in specific site collections, then leave the farm feature inactive and activate the “KWizCom Clipboard Manager for SharePoint feature” only in the requested site collection/s.

STEP 2: CONFIGURE CLIPBOARD MANAGER SETTINGS

After you activate the Clipboard Manager feature at the appropriate scope, you need to configure few settings. These settings can be configured at the site collection, site and list levels. By default, each level inherits its parent settings.

To open the Clipboard Manager Settings page, browse the Site Collection/Site/List settings page, and there click on the “KWizCom Clipboard Manager Settings” link:
The following settings page will show-up:

![Clipboard to SharePoint settings](image)

The following table describes each of the settings page’s fields:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inherit parent site settings</td>
<td>Check this checkbox if you want the settings to be inherited from the upper level. If you uncheck this checkbox you will be able to override the inherited settings and configure specific values for the current site/list.</td>
</tr>
<tr>
<td>Upload images to</td>
<td>Select the library that will be used to store pasted images. Whenever an end-user pastes an image to a SharePoint rich-text field, that image’s file is uploaded and saved in this defined library (By default it will be “Site Assets” library).</td>
</tr>
<tr>
<td>Create a sub-folder for each user</td>
<td>Check this checkbox if you want a folder to be created for each user that pastes images. Each user’s folder will store all the images that were pasted by that user.</td>
</tr>
</tbody>
</table>

In order to save your settings, click the “Save” button.
GENERAL

The Clipboard Manager for SharePoint allows content editors to easily copy & paste rich content from MS Office and images from your local PC to SharePoint rich-text fields.

The way you copy and paste remains the same as you always did – simply copy the files or content from your desktop, and then click “Paste” or press CTRL+V to paste the copied content to your SharePoint rich-text field.

IMPORTANT COMMENTS

If you are using an older version of the KWizCom Clipboard Manager:

The Clipboard Manager special ribbon buttons has been removed, now we simply override the existing SharePoint’s “Paste” button.

What happens when you paste?

When you copy rich-text with some images from your MS WORD editor for example, this content will be pasted to your SharePoint field, and all the copied images will be uploaded to the appropriate SharePoint library, so this is done automatically for you without any need for you to upload those images.
WHAT EXACTLY CAN I COPY FROM MY DESKTOP TO SHAREPOINT RICH-TEXT FIELD?

You can copy and paste rich-content, which includes formatted text, tables and embedded images.

There are 2 ways to copy content from your desktop:

1. **Copy content from opened files**
   So this way you open your MS Office file, such as an MS WORD document, mark the paragraphs you wish to copy and copy them.

   ![Image](image.png)

   On the Insert tab, the galleries include items that are designed to coordinate with the overall look of your document. You can use these galleries to insert tables, headers, footers, lists, cover pages, and other document building blocks. When you create pictures, charts, or diagrams, they also coordinate with your current document style.

   You can easily change the formatting of selected text in the document text by choosing a look for the selected text from the Quick Styles gallery on the Home tab. You can also format text directly by using:

<table>
<thead>
<tr>
<th>Font</th>
<th>Category</th>
<th>Font Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arial</td>
<td>Local</td>
<td>Normal</td>
</tr>
<tr>
<td>Times</td>
<td>Local</td>
<td>Normal</td>
</tr>
</tbody>
</table>

   To change the overall look of your document, choose two of these elements on the Page Layout tab. To change the looks available in the Quick Style gallery, use the Change Current Quick Style Set command.

2. **Copy file/s from your Windows explorer**
   If you wish to copy the entire file/s content to your SharePoint rich-text field, you don’t need to open the file and mark all its content. Instead, simply go to your windows explorer and copy the file (or several files). For example, in the screenshot below we have marked an MS WORD document, a PDF file and an image file:
When we’ll paste into our SharePoint rich-text field, the WORD and PDF file’s contents will be pasted along with the copied image.

**IMPORTANT COMMENTS**

1. **1st time you try to paste**, you will get a message asking you to install the KWizCom Client Agent tool. You must proceed with this tool’s installation before you can use the product.
2. **When you copy & paste a paragraph** that includes pictures, behind the scenes those pictures are uploaded to the SharePoint server. This means that the paste operation takes more time when you are pasting pictures (depending on the file size of those pictures and amount of pasted pictures).
3. **When copying a PowerPoint file (.pptx)**, the copied slides are converted to images when pasted to SharePoint, so if you have for example 5 slides in your PPT file, you will see 5 pasted images – 1 for each slide.
   Hidden slides will not be copied.
COPYING CONTENT OTHER THAN LOCAL DOCUMENTS/PICTURES

When you copy & Paste using the KWizCom Clipboard Manager, the copied rich-content is converted HTML before it is pasted to your target SharePoint web page.

There are some cases when you copy other content than local documents or images, for example: copying content from one web page to another.
In those cases you might not want to go through the Clipboard Manager format conversion process (because it might alter the styles), but instead simply use the out-of-the-box SharePoint paste.

In such cases, when you paste after copying from other sources than local documents, you will see after you click “Paste” the following “Bubble” offering you to choose the preferred paste option:

Where:

<table>
<thead>
<tr>
<th></th>
<th>Paste text only</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Use the out-of-the-box SharePoint paste</td>
</tr>
<tr>
<td></td>
<td>Use KWizCom Paste+</td>
</tr>
</tbody>
</table>